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INTRODUCTION

The What’s New in QuarkXPress 7 guide is for users who are already familiar
with QuarkXPress® 6.5 and need only a brief introduction to the new features.
When you first launch the application, this guide will help you locate the major
new features and explore their potential by addressing three questions: 

• What is it?

• Where is it?

• What is it good for?

The idea is to eliminate the time it takes an experienced user to answer these
simple questions when sifting through a manual filled with features old and new.
This guide also offers a comprehensive list of enhancements to existing features.
For complete information about a feature, consult A Guide to QuarkXPress 7 or
the QuarkXPress Help file.

TRANSPARENCY, DROP SHADOWS, AND ALPHA MASKING

New QuarkXPress 7 graphic features in action — white text with 80% opacity and
a drop shadow layered over a picture of a guitar, with an alpha-masked TIFF of
flames in the foreground. The logo, with its glowing drop shadow, was created
entirely in QuarkXPress.

INTRODUCTION
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WHAT IS IT?
With the new transparency features in QuarkXPress 7, you can control the opac-
ity of text, pictures, blends, boxes, frames, lines, and tables. You can specify the
degree of opacity in 0.1% increments from 0% (transparent) to 100% (opaque).
You can separately control the transparency of boxes, their contents, and their
frames. You can even create blends that go from solid to transparent, so that
items seem to fade gradually into the background.

With the new drop shadow features, you can create automatic feathered drop
shadows for boxes, lines, and text. You can control the color, positioning,
feathering, opacity, skew, angle, and runaround of a drop shadow, and even
lock all of the drop shadows on a page or spread to the same angle to give the
impression of a single light source. And full overprinting control mean your
drop shadows always print the way you want them to.

With the new support for alpha channels, you can use custom masks
(created in an image-editing application) to realistically blend objects
with page elements in the background. So, for example, you can use a
“hair mask” to place a model in front of text and other page elements.

QuarkXPress 7 also supports the transparency layer settings of PSD and layered
TIFF files.

WHERE IS IT?
• Opacity controls are color-based, so you can control transparency from any-

where you control color — including the Modify dialog box (Item menu),
the Measurements palette, and the Colors palette.

• Drop shadows can be controlled from the Drop Shadow tabs of the Modify
dialog box (Item menu) and the Measurements palette.

• You can choose an alpha channel for an imported TIFF file in the Picture tab
of the Modify dialog box (Item menu) and in the Measurements palette.

WHAT IS IT GOOD FOR?
By manipulating opacity, applying drop shadows, and utilizing alpha masks,
you can produce eye-catching, graphically sophisticated effects without leaving
QuarkXPress. That means less time spent switching back and forth between
QuarkXPress and an image-editing application (and fewer files to manage).
Best of all, items with transparency and drop-shadow effects remain 100%
editable, so you don’t have to go back to an image editing application if
changes are necessary.

TRANSPARENCY, DROP SHADOWS, AND ALPHA MASKING
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EXPANDED IMAGE EFFECTS

By blurring a picture file’s alpha mask, you can soften the boundary between an
object and the page elements in the background.

WHAT IS IT?
QuarkVista XTensions software, provided free with QuarkXPress 6.5 and later,
adds industrial strength image-editing effects to QuarkXPress. You can correct
images with adjustments to brightness/contrast, color balance, and hue/
saturation, and you can create special effects with filters such as gaussian blur
and unsharp mask. QuarkVista saves you time because it lets you change
image-editing effects at any time — right in the layout — and puts a whole
new level of creativity at your fingertips.

QuarkXPress 7 improves QuarkVista with the following new features:

• EPS/1-bit image support: Apply QuarkVista adjustments and effects to raster
EPS files and 1-bit (“line art”) pictures.

• Apply filters to alpha channels: Apply effects (such as blur) to an alpha
channel to adjust the transition between an object and the page elements in
the background. Get the right transition for the scale and background you’re
using in your layout… no guesswork required.

EXPANDED IMAGE EFFECTS
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• Contrast/Negative added: QuarkVista now provides the Contrast and Negative
features previously found in the Style menu of earlier versions of QuarkXPress.
When you open an older document or project, this functionality is automatically
mapped to the Curves, Negative, or Invert QuarkVista effects.

• Curve Enhancements: Adjust a curve by editing point values numerically
rather than dragging them with the mouse. Use a composite curve to adjust
every channel in an image simultaneously.

• Synchronization: Synchronize all picture attributes, including QuarkVista
adjustments and effects.

WHERE IS IT?
QuarkVista controls are located in the Picture Effects palette (Window menu). 

WHAT IS IT GOOD FOR?
Enhancements to QuarkVista continue to expand your ability to edit images
within the context of a layout rather than in another application. And the
integrity of the original picture file is always preserved, so you can use a single
graphic resource anywhere.

MULTI-USER PAGE COMPOSITION

Draw an area on the page with a Composition Zone tool (left), then work on that
area in a different window, place it in a different layout, or even export it to another
file so that another person can work on it (right).

EXPANDED IMAGE EFFECTS
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WHAT IS IT?
The new Composition Zone feature lets multiple users collaborate on the same
project simultaneously. Once you have designated a part of a project as a
composition zone, you and your colleagues can:

• Edit the contents of the composition zone in a different window.

• Export the composition zone to a separate file and give the file to someone else
to work on. If the file containing the exported composition zone is accessible
over the network, your layout is updated automatically as the other person
makes changes.

• Add the composition zone to the Shared Content palette and treat it as
shared content. This means you can embed the composition zone into
multiple layouts within the project. When one version changes, every
copy is updated automatically.

• Share composition zones, or even whole layouts. Other users on the network
can connect to a project containing shared content, embed the shared content
in their projects, and automatically receive updates of the shared content over
the network.

WHERE IS IT?
To set up a composition zone, you can draw an area on the page with the
Composition Zone tool, select an items and flag them as a composition
zone using the Item menu, or open the Advanced Layout Properties
dialog box to flag the whole layout as a composition zone. Once you have
created a composition zone, you can share it when you add it to the Shared
Content palette.

When sharing a composition zone, you can control whether the composition
zone is available to other projects or within the same project. 

Share a Composition Zone with the Shared Item Properties dialog box.

MULTI-USER PAGE COMPOSITION
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To view the composition zones within a project, choose File Þ

Collaboration Setup, and then click the Shared Layouts tab. To access
composition zones over a network, use the Linked Layouts tab.

You can manage composition zones with the Shared Layouts and Linked Layouts
tabs of the Collaboration Setup dialog box (File menu).

WHAT IS IT GOOD FOR?
Composition zones are ideal for fast-paced publishing environments where
different people need to work on different aspects of a page or layout at the
same time. For example, an advertising agency might have three users work-
ing on a single ad: a layout artist creating the overall look of the ad, a writer
drafting and finalizing copy, and an illustrator experimenting with different
graphics. A newsletter publisher might have a graphic designer laying out the
pages while an editor fits copy, adds captions, and enters corrections.

Large workgroups that need to not only work on the same pages simultaneously
but manage workflow as well should consider Quark Publishing System® Classic
Edition. QPS® Classic takes collaboration to the next step by routing files based
on statuses, alerting users to assignments, tracking notes and changes, and more.

MULTI-USER PAGE COMPOSITION
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JOB CONTROL WITH JOB JACKETS

The Job Jacket Manager dialog box provides a central location for specifica-
tions and rules that can help you to ensure that a project does not deviate from
its intended form.

WHAT IS IT?
Producing a successful print piece is not a simple task. Different presses have
different capabilities, and modern page layout applications must be versatile
enough to support all of them. Consequently, any number of things can go
wrong, especially when you include the inevitable possibility of simple human
error. Preflighting software helps, but wouldn’t it be nice if you could prevent
prepress problems from the beginning, instead of catching them at the end of
the process?

That’s the idea behind the Job Jackets™ feature. A Job Jackets file is an
XML file containing all of the rules and specifications necessary to describe a
QuarkXPress project. A Job Jackets file can include specifications for colors,
style sheets, trapping, and color management, as well as picture color space,
format, and resolution. It can also include information such as the page size
and number of pages, and contact information for the people involved with
a job. And it can include rules that specify legal configurations for things like
font sizes, line thicknesses, box backgrounds, and so forth.

JOB CONTROL WITH JOB JACKETS

WHAT’S NEW IN QUARKXPRESS 7 | 7



What distinguishes the Job Jackets feature from preflighting software is the fact
that Job Jackets can be created at the beginning of the process, and then given
to the layout artist. When the layout artist creates a project from a Job Jackets
file, all necessary layouts are automatically created with the defined number
of pages, as well as all of the other settings mentioned above. Periodically, the
layout artist can run an automatic check on the layout to make sure it is still
within the parameters of the job. Multiple layout artists can even connect to
the same Job Jackets file over a network.

Job Jackets also make it easier to maintain stylistic consistency within a
design group. For example, assume that a campaign requires the consistent
use of style sheets and colors, and that you want to make sure color manage-
ment settings are the same for all layout artists, so that everyone sees the
same thing on their screens. Simply include those specifications in a shared
Job Jackets file, and everyone sharing that Job Jackets file also shares those
specifications. Any changes made to shared specifications are written back to
the Job Jackets file, and communicated to other layout artists automatically
via the network.

For maximum compatibility, the Job Jackets format is based on the JDF
(Job Definition Format) standard. You can even export a JDF file when you
send a job to output — for example, to pass binding information on to a
JDF-enabled binding system.

WHERE IS IT?
Job definers can create Job Jackets using the Job Jacket Manager dialog box
(Utilities menu). Within Job Jackets are sub-structures called Job Tickets, which
contain the specifications and rules for a single project.

Layout artists can create a project from a Job Jackets file by choosing File Þ

New Þ Project from Ticket, or can link an existing project to a Job Jackets
file by choosing File Þ Job Jackets Þ Link Project.

When a project is linked to a Job Ticket, the layout artist can run an automatic
check on that project by choosing File Þ Job Jacket Þ Evaluate Layout.

JOB CONTROL WITH JOB JACKETS
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With the Layout Evaluation dialog box, a layout artist can find and correct problems
that might prevent a layout from printing correctly on the press. 

WHAT IS IT GOOD FOR?
Because Job Jackets help to stop press problems before they occur, they are
an invaluable aid to anyone creating printed materials. They also enable job
definers to control and share the resources used by related groups of projects.

VERSATILE TYPOGRAPHY WITH OPENTYPE AND UNICODE

With support for OpenType expanded character sets, you can use swash characters,
standard ligatures, discretionary ligatures, and alternate versions of characters, on
both Mac OS and Windows.

JOB CONTROL WITH JOB JACKETS
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WHAT IS IT?
OpenType® is a cross-platform font format developed by Adobe® and
Microsoft® that accommodates large character sets and works under both
Mac OS and Windows. In addition to supporting Unicode™ encodings,
OpenType fonts provide special characters such as ligatures and true small
caps, as well as alternate versions of characters. In the screen shot above,
for example, note the swash version of the “A” in “After” and the two
versions of “t” in “Attack”.

Unicode is a standard character encoding system that combines characters from
different languages into a single large coded character set, thus preventing char-
acters from different language fonts from “overlapping” with each other and
displaying incorrectly. Unicode is used widely on the Web and in international
publishing, and supports Eastern European and East Asian character sets.

With support for both OpenType and Unicode, QuarkXPress 7 helps you
to make your typography memorable, portable between platforms, and
internationally compatible.

WHERE IS IT?
Three new controls make it easy for you to insert and format special OpenType
characters: the Glyphs palette (Window menu), the OpenType controls in the
Character Attributes dialog box (Style menu), and the Measurements palette.

To view all the characters available in a font, choose Window Þ Glyphs.
One drop-down list lets you choose a font, and another lets you choose
which types of characters to display (Entire Font, European Characters,
Symbols, etc.). To add a character from the palette at the text insertion
point in the layout, double-click the character. If there are specific character
combinations you use frequently, you can save them as Favorite Glyphs at
the bottom of the palette for easy access.

When text formatted with an OpenType font is selected, you can access the
special features built into it by clicking the OpenType arrow at the bottom of
the Character Attributes dialog box (Style Þ Character). Check the appropriate
options, keeping in mind that not all font variations are available in all fonts
(unavailable features are hidden or appear in brackets). You can also access the
OpenType features by clicking the icon on the Classic and Character tabs
of the Measurements palette. 

VERSATILE TYPOGRAPHY WITH OPENTYPE AND UNICODE
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You can access special OpenType formatting via the OpenType area at the bottom
of the Character Attributes dialog box (Style menu) and the OpenType button
on the Measurements palette. 

Support for Unicode can be found in the Import Text dialog box (formerly the
Get Text dialog box). Here you’ll find a new drop-down list that lets you specify
the encoding for an imported text file. QuarkXPress 7 ships with a built-in set
of encoding converters for text in plain, HTML, and “XPress Tags” formats.
Regardless of where it comes from, text in a QuarkXPress document is stored
internally in Unicode format, meaning that you can combine characters from
different language encodings in the same document — and even in the same
text box — regardless of your QuarkXPress language version.

Another feature related to Unicode is Font Fallback, which helps QuarkXPress to
display characters in pasted or imported text that do not exist in the applied
font. When QuarkXPress encounters such characters — such as, for example,
Kanji characters to which an 8-bit western font is applied — it “falls back”
to a font that can display the characters. Font Fallback is an Application
Preference that is turned on by default (QuarkXPress/Edit Þ Preferences Þ

Input settings pane). 

WHAT IS IT GOOD FOR?
With its easy access to special characters and codes, QuarkXPress 7 makes it
easy to perfect your typography. If you’re working on a cookbook, for example,
the Glyphs palette makes it easy to find and insert fractions built into a font.
When you’re working on display type, sophisticated OpenType styles such
as Discretionary Ligatures, Swashes, and Contextual Alternates can offer the
ultimate in fine tuning. And if you work on international projects, you can use
all the various special characters and fonts required by different languages.

VERSATILE TYPOGRAPHY WITH OPENTYPE AND UNICODE
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EASIER ACCESS TO SPECIAL CHARACTERS

The new Insert Character menu item makes it easy to insert various types of special
characters without having to memorize their keyboard equivalents.

WHAT IS IT?
Special characters are not new to QuarkXPress — the application has long offered
the ability to use nonbreaking spaces, en spaces, discretionary hyphens, and
so forth. However, you had to remember the key combinations for these char-
acters, they were not easily visible after they were inserted, and there was no
easy way to find and replace them.

Now interface improvements in QuarkXPress 7 make it easy to insert special
characters without looking up keyboard commands or resorting to third-party
software. And now, Invisibles (View menu) displays the full range of invisible
characters, including discretionary hyphens, em spaces, and nonbreaking spaces.
In addition, invisible characters scale according to the point size and view
percentage. As a result, the dot shown for a space looks different at 10 points
than it does at 60 points — and it looks different at 100% than it does at 500%.

WHERE IS IT?
To insert a special character, choose Utilities Þ Insert Character and then
choose a special character. To view the new symbols for invisible characters,
choose View Þ Invisibles.

EASIER ACCESS TO SPECIAL CHARACTERS
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To view the new symbols for invisible characters, choose View Þ Invisibles.

WHAT IS IT GOOD FOR?
The Insert Character menu item makes it easier for new and old QuarkXPress
users alike to work with specialty characters — whether they be page number
placeholders, indent here characters, or flex spaces. And the new invisible
character indicators make it easier to determine what’s really going on with
hard spaces and other typographical features.

NEW SYNCHRONIZATION OPTIONS

With the Shared Content palette, you can use synchronized items and content in
different layouts within a project. 

EASIER ACCESS TO SPECIAL CHARACTERS
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WHAT IS IT?
In previous versions of QuarkXPress, you could synchronize the text in boxes
between layouts in project, but you couldn’t synchronize its formatting, and
you couldn’t synchronize pictures. QuarkXPress 7 expands this feature, allow-
ing you to synchronize both content and attributes — for both pictures boxes
and text boxes.

WHERE IS IT?
The Shared Content palette (Window menu) now stores picture boxes, text
boxes, lines, text paths, and even Composition Zones. When you add an
item to the Shared Content palette, you can specify exactly what you want
to be synchronized: item attributes, content attributes, and/or content only.
For example, you might specify that a picture box retains its attributes
(frame, background, etc.), yet contain different contents (different pictures).

Use the Shared Item Properties dialog box (Item Þ Share) to specify which
aspects of the selected item you want to synchronize.

When you use items from the Shared Content palette in other locations
within a project, and then make changes to one of those items, the changes
are reflected in all instances of that synchronized item.

WHAT IS IT GOOD FOR?
With QuarkXPress 7’s broader and more granular synchronization controls, you
gain tighter control over synchronized content. You can have multiple picture
boxes in multiple locations containing the same synchronized image, but with
independent frames, shapes, and drop shadows. Or you can go the other route,
and have numerous images in synchronized boxes, for a standard look and feel.
This means more consistency across documents and fewer errors, and helps you
to streamline your workflow for maximum efficiency — especially if you’re
doing multi-channel publishing. And when you combine synchronization
features with features like Composition Zones — allowing you to synchronize
whole areas of a page (such as, for example, a finished advertisement) and
have multiple people work on these at the same time — your potential for
time savings increases exponentially.

NEW SYNCHRONIZATION OPTIONS
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MULTIPLE LAYOUT VIEWS

Using multiple layout views, you can split a project window horizontally or vertically,
and even view the same project in a new window.

WHAT IS IT?
Users of QuarkXPress 7 are no longer limited to viewing a layout in a single
project window. You can now split a project window into multiple panes, with
a different view in each pane. You can even open a project in a new window.
And you can display whatever you want in the new panes or windows — the
same page at two different magnifications, or two different pages in the same
layout, or even two different layouts in the same project.

WHERE IS IT?
To split the active project window into two panes, choose Window Þ

Split Window Þ Horizontal or Window Þ Split Window Þ Vertical, or
simply click one of the separators next to the scroll bars. The project window
splits into two panes according to the available space on-screen. You can fur-
ther split an active project window into additional panes. You can work in
any pane, on any page of any layout, at any view scale, and the changes are
immediately reflected in every pane.

MULTIPLE LAYOUT VIEWS
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The Split Window submenu of the Window menu splits a window into
multiple views.

To open a new project window for the active project, choose Window Þ

New Window. A new project window displays on top of the existing window.
As with split windows, you can work anywhere you want in the project at any
view scale.

WHAT IS IT GOOD FOR?
The ability to view different parts of a project or layout at the same time lets you
see how detailed changes affect an entire page or layout — or even a different
layout that uses the same content. For example, if you’re editing text in a multi-
page story, you can use a second view to see how edits on page 1 affect the final
page of the story. Or if you modify synchronized text in one layout, you can
see how the changes affect other layouts. You can also make detailed edits at
a high magnification while viewing how they affect the entire page.

BETTER LAYOUT MANAGEMENT

With the File Þ Export Þ Layouts as Project command, you can export one or
more layouts from the active project into a new project.

MULTIPLE LAYOUT VIEWS
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WHAT IS IT?
The ability to store layouts of different sizes and media types within a single
project file is a convenience, but it comes with a small price: some QuarkXPress
users have experienced confusion about project vs. layout names and escalating
project file sizes. To address these concerns for customers who do not wish to
use the multiple-layout feature, QuarkXPress 7 lets you create single-layout proj-
ects and export layouts from projects. And for customers who have embraced
the multiple-layout feature, QuarkXPress 7 adds the ability to append layouts
from one project to another.

WHERE IS IT?
Controls for managing layouts are in the File menu: File Þ New Þ Project,
File Þ Export Þ Layouts as Project, and File Þ Append.

To create a project that contains only one layout — and therefore uses the
same file name for the layout and the project — check Single Layout Mode
in the New Project dialog box (File Þ New Þ Project). A single-layout proj-
ect is essentially the same thing as a document in QuarkXPress 5.0 or earlier
(although the file name still ends in a .qxp suffix on Windows). If you create a
project with Single Layout Mode checked, however, you are not stuck in this
mode; you can simply use Layout Þ New to add new layouts to the project. 

If you need to share a layout with another user, decrease the project file size,
or create a template from a layout, you can export the layout by choosing
File Þ Export Þ Layouts as Project. Use the Export Layouts as a Project
dialog box to specify the layouts to export and the export format. 

Use the Export Layouts as a Project dialog box to choose which layouts to export.

BETTER LAYOUT MANAGEMENT
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If you need to use content of a layout in another project, you can simply
append that layout — pages, contents, and everything — into the other
project by choosing File Þ Append. 

WHAT IS IT GOOD FOR?
These new management tools make working with layouts within projects sig-
nificantly more flexible. If you prefer to work “the old way,” you can simply
check Single Layout Mode for all new projects. If you like working with proj-
ects but need more flexibility, exporting layouts from projects lets you create
discrete layout files that you can send to other users. And the ability to append
layouts not only prevents you from having to cut and paste items between
projects, but can also streamline the process of creating several similar layouts.

SUPERIOR PALETTE CONTROLS

With QuarkXPress 7, you can create custom palette groups that keep the palettes
you need at your fingertips. 

BETTER LAYOUT MANAGEMENT
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WHAT IS IT?
Palettes provide quick, interactive access to features — but they also take up
screen real estate. To maximize your workspace, you can now create custom
palette groups that you can hide and display with a single keyboard command.
Within each palette group, you can expand, collapse, and resize palettes
according to your needs. 

WHERE IS IT?
To create a palette group, first open one of the palettes by choosing its name
from the Window menu. Then Control+click/right-click the palette’s title bar
to display a context menu, and choose the name of the palette you want to
group with the current palette.

The Palette menu provides controls for adding and removing palettes from a
palette group.

When palettes are grouped, you can:

• Move the palettes as a group by dragging the top bar.

• Display or hide an individual palette within a palette group by clicking its
title bar. 

SUPERIOR PALETTE CONTROLS
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• Close all the palettes by clicking the close button.

• Rearrange the palettes by dragging them up and down through the group.

• Collapse the palette group by double-clicking its top bar.

• Remove a palette from a group.

Once you have a configuration of grouped palettes that you like, you can save
them as a palette set. A palette set remembers which palettes are open, how
they are grouped, and where they are on the screen. To create a palette group,
choose Window Þ Palette Sets Þ Save Palette Set As, give the palette set a
name (which displays in the Palette Sets submenu of the Window menu), and
specify a keyboard command for showing and hiding the palette set.

Save palette configurations — including palette grouping, size, and position — with
the Save Palette Set As dialog box (Window Þ Palette Sets). 

To use a palette set, choose its name from the Palette Sets submenu of the
Window menu or press its keyboard command. 

WHAT IS IT GOOD FOR?
Grouping palettes and saving them as sets gives you quick access to exactly
the controls you need. You can group palettes on the fly, depending on what
you’re working on. Or, you can create different palette sets for different pub-
lishing tasks. For example, you might have the Style Sheets, Lists, and Indexes
palettes showing while working on the text in a book, but you might have
the Colors, Picture Effects, and Layers palettes showing while working on
an advertisement. You can even include libraries in a palette group. By pre-
venting clutter on-screen, you can see your design work better, and by quickly
hiding and showing the tools you need, you can be more productive.

SUPERIOR PALETTE CONTROLS
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IMPROVED LOCKING

You can now separately lock an item and its contents.

WHAT IS IT?
Previous versions of QuarkXPress let you lock the position of an item, but
such locking only protected items from movement by the mouse; you could
still move or change them with the Measurements palette or Modify dialog
box (Item menu).

QuarkXPress 7 provides more comprehensive locking, and allows you to lock
both items and content.

WHERE IS IT?
You can now lock an item’s position so it cannot be changed, neither with the
mouse nor with the Modify dialog box (Item menu) or Measurements palette,
by choosing Item Þ Lock Þ Position. To lock the content of an item, without
locking the item itself, choose Item Þ Lock Þ Picture or Item Þ Lock Þ Story.

WHAT IS IT GOOD FOR?
The new enhanced locking features in QuarkXPress 7 help you to avoid acci-
dental changes that might interfere with or even ruin a job. So, for example,
now you can lock both the position and content of a picture box containing
a newspaper’s masthead, but lock only the position of the text boxes where
the articles flow. 

IMPROVED LOCKING
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IMPROVED COLOR MANAGEMENT

QuarkXPress 7 makes it easy to preview a layout and its imported pictures as it would
look when output to various color spaces. 

WHAT IS IT?
QuarkXPress 7 provides a number of improvements in the area of color
management. You can preview a document as it will appear on various output
devices by choosing an item from a menu, and thus see, for example, how RGB
pictures and page elements will appear when printed to a CMYK device or in
grayscale. You can have complete nuts-and-bolts control over your color man-
agement on an application-wide basis, or you can get great results with the
carefully constructed set of default color management settings. And if you want
to ensure maximum backward compatibility, you can configure QuarkXPress 7
to use the same color management settings it used in version 3.3, 4.0, or 6.0.

IMPROVED COLOR MANAGEMENT
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Perhaps most significantly, color management settings can be contained in
Job Jackets — meaning that you can receive color management settings from
your output providers, based on the color workflow they use. That means
top-notch color management with a minimum of effort.

WHERE IS IT?
In QuarkXPress, color management has two basic components:

• A source setup describes colors as they exist prior to output. A source setup
contains profiles and rendering intents for imported picture files in all sup-
ported formats, and specifies the underlying color space for colors used and
created in QuarkXPress. You can think of a source setup as “where colors
come from.”

• An output setup describes the limitations of various types of output devices.
The output setup determines which colors can be used in an output simulation.
You can think of an output setup as “where colors are going.”

When you choose an output option from the View Þ Proof Output submenu,
QuarkXPress uses the source and output setup to display the layout as it would
look when output with that option (as closely as possible). For example, if you
choose View Þ Proof Output Þ Process and Spot, QuarkXPress locates the
appropriate profiles in the source and output setups, uses them to perform ICC
transformations on the colors and the imported pictures in the active layout,
and then displays the layout as it would look when printed in CMYK with
spot color inks. If you choose View Þ Proof Output Þ Convert to Process,
even spot colors as they would look when separated and printed to a CMYK
press. This process is known as display simulation.

QuarkXPress 7 includes a default source setup and output setup that should
work well in most situations. However, if you have a specialized situation or
desire more comprehensive color control, you now have access to all of the
controls you need to create your own source and output setups. An output
provider can even include customized source and output setups in a Job
Jackets file, and then give that Job Jackets file to customers, so that the layout
artists can see, as accurately as possible, what their pages will look like when
printed on the target press. To apply a source setup, just select it from the
Source Setup drop-down list in the Color Manager pane of the Preferences
dialog box (QuarkXPress/Edit menu).

IMPROVED COLOR MANAGEMENT
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The Edit Source Setup dialog box (Edit Þ Color Setups Þ Source Þ New) and
Edit Output Setup dialog box (Edit Þ Color Setups Þ Output Þ New) provide
precise controls for defining profiles and rendering intents for color management
and display simulation. QuarkXPress 7 ships with default source and output setups
that should work well in most situations.

For special situations, you can manually apply profiles and rendering intents
to individual imported pictures. But for the vast majority of jobs, you don’t
even have to think about it — you can just work as usual, and effortlessly take
advantage of the default settings that ship with QuarkXPress 7 or the custom
settings you’ve imported from a color expert or service provider.

WHAT IS IT GOOD FOR?
Accurate color management saves time and money by preventing costly print-
ing mistakes, and increases the satisfaction of customers who order high-quality
print jobs. The better a layout artist or designer can judge colors on-screen, the
fewer unpleasant surprises they’ll have when the job goes to press.

Quark® is continually working to make color management tasks easier, so that
more users will embrace and benefit from soft proofing. 

IMPROVED COLOR MANAGEMENT
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EXPANDED OUTPUT OPTIONS AND OUTPUT STYLES

QuarkXPress 7 offers a plethora of export formats, and lets you use Output Styles
to store output options for print, PDF, EPS, and PPML output.

WHAT IS IT?
QuarkXPress 7 enables true multi-format publishing by expanding the list of
supported output formats to include print, PDF (including PDF/X-1a and
PDF/X-3 verification), HTML, XHTML, XSLT, XML, and PPML. And to help
you maintain control over the various options offered by each of these output
formats, QuarkXPress extends its popular Print Styles feature into a new feature
called Output Styles.

To complement its existing print styles — which save complex print settings as
named files that you can use for consistent output and share with other users —
QuarkXPress includes styles for saving EPS, PDF, and PPML output settings. 

WHERE IS IT?
The various output options are available via the menu items File Þ Print
(for print), File Þ Save As (for EPS), and File Þ Export (for the other formats).

To save settings for various output types, choose Edit Þ Output Styles.
The Output Styles dialog box lets you create, edit, import, and export files
of output settings. (PDF/X certification controls can be found in the Edit
PDF Style dialog box.)

EXPANDED OUTPUT OPTIONS AND OUTPUT STYLES
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Set up frequently used output configurations with the Output Styles dialog box
(Edit menu).

In the Edit PDF Style dialog box, you can specify PDF/X compliance and
other options.

PDF/X is a version of the PDF format designed specifically for eliminating prob-
lems from print production. When creating output styles for PDFs destined for
print output, you can choose PDF/X 1a or PDF/X 3 verification.

WHAT IS IT GOOD FOR?
Quark’s expanding list of standards-based output formats helps ensure that
you can publish content in a variety of formats for a variety of channels.
For example, you can publish the same document in PDF format for online
distribution, PDF/X format for output, HTML for posting on the Web, and
XML for repurposing.

EXPANDED OUTPUT OPTIONS AND OUTPUT STYLES
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Output styles ensure consistent output for both individual users and workgroups.
For example, you might have an output style for PDFs destined for prepress
and another style for PDFs destined for downloading and on-screen viewing.
By exporting such styles, you can share them in a workgroup. Using styles in
this way not only saves time, but can prevent costly output errors.

MORE FEATURE ENHANCEMENTS

In addition to the major features listed above, QuarkXPress includes a number
of minor enhancements designed to address customer requests and improve
the usability of the application.

RETAINING PICTURE ATTRIBUTES WHEN REPLACING PICTURES
When you replace the picture in a picture box, you have the option to retain
all the picture box’s attributes — including scaling, positioning, rotation, and
QuarkVista effects. You can also apply picture box attributes to empty boxes
(for example, in master pages and templates).

You now can check Maintain Picture Attributes to hold on to image modifications
when importing a new picture file.

EXPANDED OUTPUT OPTIONS AND OUTPUT STYLES
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IDENTIFYING LAYER ITEMS WITH LAYER COLORS
The bounding box of an item on a layer now displays with the layer’s color,
so you can easily tell which layer an item is on.

EMBEDDING FONTS IN EPS FILES
When you save a page as an EPS file, you can now embed the fonts used on
that page in the EPS file. This relieves you from having to ensure that fonts
are provided with EPS files for output.

To embed fonts in an EPS file, click the Options button in the Save Page as EPS
dialog box, go to the Fonts pane, and check the fonts you want to embed.

IMPORTING SWF FILES
You can now import SWF files (files in Flash® format) directly into Web layouts
(File Þ Import Picture) and export SWF files in HTML files (File Þ Export Þ
HTML). SWF files are embedded in the HTML to allow you to create dynamic
Web sites. Using SWF files, you can easily import dynamic buttons, forms,
animations, sounds, and videos to make Web pages more interactive.

LIGATURES ON-THE-FLY
You can now turn ligatures on and off for individual character sequences in
the Character tab of the Measurements palette. Previously, ligatures were
either on or off for an entire layout.

GET CHANGED TO IMPORT
The Get Text and Get Picture commands in the File menu are now named
Import Text and Import Picture. 

MORE FEATURE ENHANCEMENTS
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ANTI-ALIASED DISPLAY 
Due to improved anti-aliasing, QuarkXPress items and contents now display
more smoothly — both on the screen and when exported to HTML. 

IMPROVED SPACE/ALIGN
The Space/Align Items dialog box is now available as a tab in the
Measurements palette, and you can now use it to align items to page/spread
boundaries. Keyboard commands are also provided for the alignment feature.

MEASUREMENT PALETTE ENHANCEMENTS

The Measurements palette now contains tabs at the top that change according
to the selected item. 

The Measurements palette, now tabbed, provides access to a wide range of features,
including many Modify dialog box features such as clipping and runaround. 

Each tab allows you to perform a different set of actions:

TAB CONTROLS

Classic Contains controls from previous versions of QuarkXPress.
Displays differently for text boxes, picture boxes, lines,
and tables.

Text Contains the controls of the Text tab of the Modify
dialog box (Item Þ Modify).

Frame Contains the controls of the Frame tab of the Modify
dialog box.

Runaround Contains the controls of the Runaround tab of the
Modify dialog box. Displays differently for text boxes,
picture boxes, and lines.

Clipping Contains the controls of the Clipping tab of the Modify
dialog box.

Character Contains the controls of the Character Attributes dialog
box (Style Þ Character).

Paragraph Contains the controls of the Formats tab of the
Paragraph Attributes dialog box (Style Þ Formats).

Tabs Contains the controls of the Tabs tab of the Paragraph
Attributes dialog box.

Export Contains the controls of the Export tab of the Modify
dialog box (Web layouts only).

MORE FEATURE ENHANCEMENTS
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TAB CONTROLS

Text Path Contains the controls of the Text Path tab of the
Modify dialog box.

Grids Contains the controls of the Grid tab of the Modify
dialog box (selected tables only).

Space/Align Contains the controls of the Space/Align submenu
(Item Þ Space/Align).

Drop Shadow Contains the controls of the Drop Shadow tab of the
Modify dialog box.

TABLE ENHANCEMENTS
QuarkXPress 7 contains greatly expanded support for tables. All table features
have been consolidated into the new Table menu. You can now:

• Split non-anchored tables so that they can be continued on another page, and
add automatically-repeating header and footer rows (Table Þ Table Break).
Changes made to certain attributes of a split table are automatically made to
the rest of the table, too. 

• Create automatically synchronized header and footer rows for continued
tables (Table Þ Repeat as Header and Table Þ Repeat as Footer).

• Configure cells to expand automatically to accommodate their contents
(Auto Fit in Item Þ Modify Þ Cell tab).

• Automatically select all even rows, even columns, odd rows, or odd columns
in a table for formatting (Table Þ Select submenu).

• Rotate tables.

• Group tables.

MEASUREMENT PALETTE ENHANCEMENTS
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